## Contents

**Preface** ................................................................. 5

- Important Information ............................................. 6
  - About LanSchool ............................................... 6
  - Product Documentation ....................................... 6

- Supported Environments ........................................... 7
  - Tech Console .................................................. 7
  - Report Server ............................................... 8

- Technical Support .................................................. 9
  - Contact Information .......................................... 9

**Using Tech Console** ................................................ 10

- Getting Started .................................................... 11
- How Tech Console Works .......................................... 12
- Using the Console ................................................ 13
- About the User computers ....................................... 14
- User Interface Tips ................................................ 15
- Tech Console Feature Overview .................................. 17
  - Manage ........................................................... 17
  - Monitor .......................................................... 23

- Tech Console Configuration Preferences ....................... 24
  - Tech ............................................................. 24
  - User ............................................................. 24
Preface

Thank you for selecting LanSchool Tech Console. Tech Console provides a central management view of the users and devices in your environment. It allows technical administrators and IT staff to gather hardware and software inventory, keep everything up-to-date, monitor security risks, provide efficient support to your teaching staff, save power and report on technology utilization.

This user guide explains how to use Tech Console. It was last updated on September 9th, 2016.

Topics

- Important Information
- Supported Environments
- Technical Support
Important Information

This section contains important information about your LanSchool Product.

About LanSchool

Since 1986 LanSchool has delivered market-leading software that helps teachers, professors and trainers teach more effectively in a 21st century classroom. With the introduction of Tech Console, LanSchool will also provide IT and Tech Coordinators with the tools to help them accomplish their daily tasks.

Product Documentation

The following documents form the LanSchool Tech Console documentation set:

- *Tech Console Install Guide* (tcinstall.pdf) — This document helps you to install the product.
- *Tech Console User Guide* (tcusers.pdf) — This document guides you how to use the product.

Supported Environments
# Supported Environments

## Tech Console

LanSchool Tech Console supports the following operating systems for the console or student:

- Windows XP-32
- Windows Vista-32/64
- Windows 7-32/64
- Windows 8-32/64
- Windows 10-32/64
- Mac OS X 10.7 or greater

Please note that Tech Console for the Mac will only run on Intel-based Mac hardware running OSX 10.7 or greater.

Tech Console is a stand-alone product designed to help IT and Technical staff with their daily tasks. It includes the Student.exe file for Windows and the lanschool-student.dmg for Mac, which is the agent piece to be installed on the clients you will manage with the console. However, Tech Console uses the same client software as LanSchool v8.0 and can be used to manage both LanSchool v8.0 students and teachers if both products are installed.

So by convention and for simplicity, this guide will generally refer to the client piece being managed (which could be a Student or a Teacher) as the user. There are some cases where a Tech Console feature may be implemented somewhat differently depending on whether the underlying software installed was a Student or a Teacher package, but those differences will be noted.

Tech Console will also discover previous versions of LanSchool, but to function properly, the client pieces must be updated to the 8.0 version. Fortunately, you can use the Tech Console to easily update earlier versions of LanSchool Mac and Windows teachers and students.

Listed below are the minimum requirements necessary to run Tech Console:

**Processor**

PCs: 166 MHz Intel® Pentium® processor or faster

Macs: 64-bit Intel-based Mac’s

**RAM**

- 128 MB for Windows XP
- 256 MB for Windows Vista
- 256 MB for Windows 7/8
- 512 MB for Mac OS X
Report Server

Included with the LanSchool Tech Console is an additional install for the LanSchool Report Server. The Report Server retains the software and hardware inventory information scanned from Student machines. If it is installed in combination with LanSchool v8.0 Classroom Management software, inventory information from Teacher machines is also captured. This data capture allows you to record and analyze your technology utilization with the reports provided like Web Site Visits and application usage by Student or Computer.

The Report Server is a stand-alone install that includes a SQLite database and the ASP.NET web framework. It may be installed on the same machine as the Windows Tech Console software, but only one install of the Report Server should be implemented. Once installed, it “announces” its presence to all Tech Consoles available. It can be accessed by the Reports toolbar button on an individual Tech Console, or through a browser by its IP address.

The same Tech Console Processor and RAM requirements are necessary for the Report Server, although it is recommended to increase the RAM to at least 1G. The Report Server initially requires under 60MB of disk space to install, though additional space is needed as inventory is collected. The amount of disk space needed will vary depending on the number of machines in your environment, but the inventory data captured does not require significant space and the ongoing collection of web history data and application usage is very small.

The Report Server supports the following operating systems:
- Windows 7 64 bit
- Windows 8 64 bit
- Windows 10 64 bit

Product and database backup is strongly recommended, though refreshed inventory information is gathered once a day. Backing up the Report Server will insure the protection of your historic usage data.

As the Report Server includes a web server, it should not be installed on a machine with any other web server. Some types of software, such as Skype®, behave similarly to a web server, and should therefore either be configured to listen on a different port if present on the same machine, or be removed from that device. At this time, the Report Server does not include dynamic port allocation and it “listens” on port 80 for broadcasts from local Tech Consoles.

Protocol stack

All computers running Tech Console, the Report Server, or the Student or Teacher software must be configured with TCP/IP running static or dynamic IP addresses. 802.11 wireless is supported, however enterprise class access points are recommended.
Technical Support

Every effort has been made to design this software for ease of use and to be problem free. If problems are encountered, please contact Technical Support.

Email: support@lenovosoftware.com
Phone: 1-877-394-0443 (Toll Free USA), 1-260-492-2357 (International)
Hours: 8:00am to 6:30pm (Eastern Time)

Contact Information

- Web: http://www.lenovosoftware.com/lanschool
- Email:sales@lenovosoftware.com
- Phone: 1-888-473-9485 (Toll Free USA), 1-860-819-3774 (International)
- Fax: 1-866-596-2088 (USA Fax), 1-317-229-6320 (International Fax)
- Hours: 8:00am to 5:00pm (Mountain Time)
- Address:
  Stoneware Inc.
  PO Box 3352
  Carmel, IN 46082
  USA
Using Tech Console

This chapter describes how to use LanSchool Tech Console.

Topics

- Getting Started
- How Tech Console Works
- Using the Console
- About the User computers
- User Interface Tips
- Tech Console Feature Overview
- Tech Console Configuration Preferences
Getting Started

The Tech Console product includes the setup files needed to install the Console, and the Report Server. If Tech Console isn't already installed, refer to the Tech Console Installation Guide (tcinstall.pdf) for instructions on how to install the product. Once it is installed, follow this guide to begin using the product.
How Tech Console Works

LanSchool Tech Console works by enabling the console application to see all computers with the client agent software installed.

It uses “channels” to ensure that all the computers are visible; much like a TV channel enables different TVs to see the same program. There are 16,000 channels from which to choose, which you may assign by any logical scheme that fits your environment.

After installing the agent software on the devices to be managed, the console will discover those machines and automatically add them to the User List. As a stand-alone management solution, you may assign all users to Channel 1 or divide the devices into logical “groups” based on your own criteria. You may assign a channel to a group of users by grade, by classroom location or another internal attribute.

For instance, you could assign all the devices on the first floor to Channel 100, the devices on the second floor to Channel 200, and so on, which would work well if the devices were not mobile. If the Tech Console is configured to see the devices on Channel 100, then it would only see the machines on the first floor. Alternately you could assign channels by user characteristics, such as Last Name or Grade Level. The Tech Console can be configured to operate on a single channel, a group of channels, or a special administrative channel “0”, (zero), in which case it will see all channels and therefore all devices in a given environment.

If Tech Console is installed in conjunction with LanSchool v8.0 Classroom Management software, it is a good idea to follow the recommendations provided in the LanSchool installation and user guides for setting up Student computer channels by Teacher, classroom, or Class List. Tech Console will not need to install any agent software if LanSchool v8.0 is previously installed, as the two products share the same Student agent. However, the software on the user systems should be updated to the latest 8.0 version in order for Tech Console features to work properly. In addition to discovering Students deployed with LanSchool v8.0, Tech Console will also discover Teacher computers as well, though those devices are treated somewhat differently than Student devices. The unique behavior is noted in the specific feature when pertinent.
Using the Console

The use model for Tech Console is quite similar to LanSchool Teacher consoles. On the Tech Console computer, you will see a small LanSchool icon (it looks like a computer monitor with a small green “circle of circles” on its screen) in the system tray. The system tray is located in the bottom right corner of your computer screen. You will use this menu to access the Tech Console when installed on a Windows computer. On a Mac, the Tech Console menu can be accessed from the dock icon.

More advanced features are available once you launch the console. The console can be accessed by “left-clicking” on the Tech Console system tray icon or dock icon or launching it from the Start menu on Windows or the Applications folder on Mac.

In the console, the key product features are available as icons on the toolbar, or from items on the menu. It is also possible to right-mouse click on computer thumbnails to access available features.

When selecting computer thumbnails, we recommend using ctrl-a to select all computers or hold down the ctrl key and click with your mouse to select a group of computers. On the Mac use command-a to select all computers. In the thumbnail view you can select multiple computers by just selecting them with the mouse.

When using the toolbar buttons, a single click enables that feature and presses the button. Another click will disable that feature, just like a toggle switch.
About the User computers

The client software is set up to run in the background on user’s computers. Users will automatically be discovered and added to the list of devices that may be managed, provided that the network is functioning properly and the appropriate selections have been made in the Network tab for Multicast or IP-Directed Broadcast configuration.

LanSchool Icon

A LanSchool icon (green circle of circles) appears in the system tray at the bottom right corner of the computer screen in Windows. On the Mac it appears as a small icon at the top of the screen.

If you place your cursor over the icon on Windows or Mac, it will tell you which channel the user is on.

If a Student single clicks on this icon they can request help. They can type a question and a small question mark is displayed in the console indicating that a user has a question. The question mark goes away when the Tech chats with the user or uses the menu item Clear User Question or Alert.

If the Student right clicks on this icon, it will bring up the student file folder where the Send/Collect files feature sends files.

If the user is a Teacher, the icon will also show the channel the user is on. However, a single or right-click of the icon launches the Teacher console, and a left-click displays a number of key actions that a Teacher can take. To send a question to the Tech from this type of user, the Teacher should select Ask Technician a Question from the Help menu in the Teacher console.
User Interface Tips

Tech Console was designed to be simple and easy-to-use. It is launched from the Start menu, which also places a computer monitor icon in the system tray. When the console is minimized, you can click on the icon to re-launch it. Hovering with your mouse over the icon will display the channel, version and IP address of the Tech Console.

Tech Console Toolbar Buttons

To use a feature in Tech Console, select the desired user(s) and press the Tech Console toolbar button that corresponds to the feature that you want to use. At that point the button will depress and change to a lighter color. To stop using that feature, click the button again.

Some of the toolbar buttons have a little arrow to the right of the button. Click on the button to access additional options for that feature.

Buttons can be added, removed or moved by clicking on View then Configure Toolbar on a PC or Customize Toolbar on a Mac.

Multiple Select

It is possible to select one, several or all users in the User List.

To select multiple users, use the standard Windows ctrl click method. You can also select the entire list with the ctrl-a key sequence. On the Mac use command-a to select all computers.

In the details view, the line item will turn a bluish gray when selected. In the thumbnail view, the thumbnail will have a thick red line surrounding it. It is not necessary to use the Windows ctrl click in the thumbnail view. In the thumbnail view you can select multiple thumbnails by clicking on another thumbnail.

Once you have selected the desired users, you can right-click on that selection and then get an advanced options menu, or you can click on a toolbar button or console menu.

Unselect Users

To unselect users, click on a blank area of the console.

Selected Only

In thumbnail view you can just watch a few machines by selecting those machines and pressing the Selected Only menu beneath the arrow on the View All button.

Implicit ALL Selection

If no users are selected, there is an implied “all” selection when activating a a supported feature. For example, if no users are selected you can click the Blank Screen toolbar button and all of the machines in the list will have their screens blanked.

Right-mouse click

In the console you may access advanced features by right-mouse clicking on users in either the Details or Thumbnail view.
Refresh Screen

Pressing F5 on a PC or command-r on a Mac or the menu item View -&gt; Refresh will refresh the console by initiating a re-discovery of computers on the channel.

Sorting

By default, the detail view is sorted alphabetically by the Login Name column. If you click on any of the other column headings, the list will sort on the selected column.

Show Tooltips

Show Tooltips will either Show or Disable tooltips in the thumbnail view.

Magnify Thumbnails

The magnify menu on the View All button turns on or off the ability to hover over a thumbnail and have it expand temporarily to a larger size.
Tech Console Feature Overview

Tech Console includes a number of features designed to provide IT and Tech Coordinators with tools to help them accomplish their daily tasks. All of the features are grouped under one of four menu items: Manage, Monitor, Restrict, Communicate, and View. The most commonly used features are also accessible by selecting one of the toolbar buttons.

Manage

Inventory

View the hardware components and installed software of the discovered user machines.

The first time the Tech Console is launched, a background scan process begins that connects with each user machine in the discovered list. It queries the device for its specific hardware and software data and gathers that data in a file that is stored on the Tech Console. This process can take several minutes to gather from the client machine. Once a scan is completed, however, the data is quickly displayed in a pop-up window in the console when Inventory is selected from the Manage menu or the toolbar button.

If a Report Server has also been installed, Tech Console will post that data to the Report Server for each machine in the User List. After the initial scan is completed, the Tech Console checks the machine once a day for new information and re-posts that data to the Report Server.

Multiselect is not available for the Inventory feature as the data is, of course, unique to each machine. As the quantity of data gathered per device is quite extensive, you can also search this information to quickly find data in a specific category or field. The inventory data is aggregated in the Report Server, so you are able to view summary information such as how many devices have a certain application installed or what number of machines are running a particular operating system. You can also find the time that a machine was last scanned by looking at the Last Update column in the Computer List report.

Security

Compare a machine to the “Healthy computer” definition, and remotely modify those settings for the security categories determined.

Tech Console provides a default definition of a Healthy computer based on recommendations by Microsoft and Apple for their respective operating systems. This definition “checklist” is available in the Security tab of the Preference item in the Manage menu.

The Security tab lets you configure the settings that define a “Healthy computer” in your environment. Each user machine is compared to these settings and if the setting on the user machine matches this definition, then the machine is determined to be “healthy” and a green shield will be displayed in the User List. If even one category doesn’t match this definition, then the shield will turn red.

For example, if you were to check every box in the Security Preferences tab, all machines would always be displayed as healthy as every possible choice would be covered, i.e. Anti-Virus protection could be present or it could be absent, but that case would be true for every machine. Alternately, if you cleared every setting in this dialog, all user machines would always be displayed “unhealthy” or “At Risk” with red shields in the User List. This is because no machine could both have and not have Virus Protection at the same time.
The Security definition is global and applies to all machines, or in other words it can’t be configured on a per device basis. The categories included in the definition have slightly different nuances on Windows versus Mac user machines, but they are mostly the same in the context of the particular operating system.

There are six areas that determine whether the device is “Healthy” or it is “At Risk.”

**Windows/Personal Firewall**

Possible settings are:

- On
- Off

You may select either or both options based on your environment. Setting this to On means that Tech Console will check to determine whether the firewall provided by the operating system is present and turned on for every user in the List. If so, this setting will pass the “healthy” checklist.

This check does not include the ability to understand third-party firewall applications. If you use a product outside of the one provided by the Windows or Mac operating systems, then you may want to check both On and Off so that this category is fundamentally always healthy because you are managing that aspect of security independently.

**Operating System Updates**

Possible settings are:

- Automatic (Download and Install)
- Download (Don’t Install)
- Notify Only
- Disabled

You may select any individual setting, a combination of two or more, or all four settings if this is not a setting you care to have impact your definition of a Healthy computer.

**Virus Protection**

Possible settings are:

- On
- Off

You may select either or both options based on your environment. Setting this to On means that Tech Console will check to determine whether the operating system reports that Anti-Virus protection is available and running on the machine. This category may not be modified from the Security tab, as it is necessary to install the Anti-Virus software, not just change a setting on the user machine.

**Malware/Spyware**

Possible settings are:

- On
- Off
You may select either or both options based on your environment. Setting this to On means that Tech Console will check to determine whether the operating system reports that Malware/Spyware protection is available and running on the machine.

This category may not be modified from the Security tab, as it is necessary to install the Anti-Virus software, not just change a setting on the user machine.

**Internet Security Settings**

Possible settings are:

- Phishing Filter On
- Phishing Filter Off

You may select either or both options based on your environment. Setting this to On means that Tech Console will check to determine whether the operating system reports that Phishing Filter protection is available and running on the default browser installed on that machine.

**User Account Control**

Possible settings are:

- Always notify when I make changes, or programs make changes
- Notify when programs make changes (Default)
- Notify when programs make changes (don't dim screen)
- Never notify when I make changes, or programs make changes

User Account Control (UAC) is a uniquely Windows concept that is not present on Macs or operating system versions before Vista. As such, those platforms do not consider this setting in the determination of health. For Vista and Windows 7 user machines, select the appropriate combination of options based on your environment. Tech Console will compare the setting here to the choice made on the local user’s machine, and if they match exactly, then this setting will contribute positively to the “healthy” definition.

**Install**

Distribute software packages remotely to user machines.

In order to install or uninstall applications or software updates to remote machines, the devices must be on and logged in. Browse to the package that you wish to deploy, and add any pertinent command line options that the package understands. The supported package types include:

- .msi
- .exe
- .pkg

By default, if no command line options are provided for .msi files, those packages are installed silently. There are a number of standard options available for configuring .msi installs, and those options are detailed in the Help menu in the Install dialog.

Mac .pkg files will be installed using the Apple installer to the root volume (-target /). This package type may only be installed from a Mac Tech Console. If you want to deploy a .pkg file from a Windows Tech Console, the .pkg file must first be zipped.
After selecting the package and entering any command line options necessary, select **Start** to begin the process. You will be prompted for user credentials on the remote machine. If you selected multiple machines to install the package to, the credentials must be valid for all machines in the list.

The Install feature will provide status messages at three distinct points in the distribution. The status message include the points where the package is:

- Downloading the file
- Beginning the install
- Install exits

Status is not updated at interim points in any of the three stages, and each stage can take several minutes to complete depending on the size of the file and the complexity of the install. When the install ends, if the package returns an exit code, that code and any available message related to the code will be displayed upon completion.

If an install is terminated before a successful completion status is returned, the dialog is cancelled and closed, but the install most likely will continue unless it was stopped while still in the download stage.

**Power**

View the current battery status and control the power schemes in use.

Monitors the battery state on a notebook. If the charge drops below 50%, a yellow warning battery icon is displayed. If the charge drops below 20%, a red critical battery icon is displayed. The percentage of power remaining and the current A/C status is also available.

The current power scheme in use is also displayed, in addition to the alternate schemes that are already available. The scheme can be modified from the console by selecting an alternate choice and providing the credentials for that machine.

**Deep Freeze**

Centrally manage Deep Freeze settings on supported computers.

Faronics provides a tool for Windows 7 / 8 and Mac OS X Tiger 10.4, Leopard 10.5, Snow Leopard 10.6, Lion 10.7, or Mountain Lion 10.8 systems called Deep Freeze. Deep Freeze gives administrators enhanced options for configuring shared computers, such as desired state protection. Once Deep Freeze is installed and enabled, you can modify the Deep Freeze state. Tech Console provides the ability to view which of two settings are in force, and allows you to change that setting remotely. The two options possible are:

**Frozen**: This option will have the machine reboot and enter a Frozen state, any changes made to a machine in a frozen state are reversed each time the machine is rebooted. Deep Freeze must be in a Frozen state for the machine to be protected.

**Thawed**: This option will have the machine reboot and enter a Thawed state. Changes made to the machine, such as installing a new program or system updates, are retained even after a reboot.


**NOTE**: This is only an issue on the PC editions of Deep Freeze and does not impact Deep Freeze for Mac.
SteadyState

Centrally manage Microsoft SteadyState settings on supported computers.

Microsoft provided a tool for Windows XP and Vista PCs called SteadyState.msi that gave administrators enhanced options for configuring shared computers, such as hard drive protection. Once the tool is installed, and Disk Protection is turned on, you can modify the behavior. Tech Console provides the ability to view which of three settings is in force, and allows you to change that setting remotely. The three options possible are:

**Remove all changes at restart:** This option will eliminate any change made to the machine from the point Disk Protection was turned on until you reboot the machine. Use this setting to setup a machine to a clean state and then can get it back to that clean state by simply rebooting it.

**Retain changes temporarily:** This option will allow to set a time for any changes made to survive a reboot. After that point, changes will no longer be retained.

**Retain changes permanently:** This allows you to make changes and they will survive a reboot. This is basically like the machine would normally behave and the state you should use when software updates or new applications need to be installed to the base system.

Run a program

Execute a program remotely on a user machine with the proper credentials.

Power on or Wake-On-LAN

If your user computers are configured to take advantage of Wake-On-LAN technology, Tech Console can “power-on” all PC’s.

Most computers ship with the Wake-On-LAN option turned off in the BIOS, so you must go into the BIOS setup at boot time and turn it on.

Apple’s version of Wake-On-LAN will wake a Mac from sleep but will not power-on a Mac that is off.

User Power-Off

Log off, restart or power off user computers.

Remote Login

From the Tech Console you can remotely login into Windows machines if the user has a password and the Welcome screen is not displayed. This is the screen which displays icons with the last successfully logged in users, instead of requiring the person to type in their name. Logging on at the Welcome screen is not typically available on computers that are members of a network domain, but it is the default for most PCs that are simply members of a workgroup. You can modify this behavior on those machines if desired. The manual steps to change from the Welcome screen to the default name and password screen are different on XP than on Vista and Windows 7:

**XP**

1. As a user with administrator rights, open User Accounts in the Control Panel.
2. Click Change the way users log on or off.
3. Clear the “Use the Welcome screen” check box.

**Vista and Windows 7**
As a user with administrator rights, open Local Security Policy in Administrative Tools in the Control Panel.

Go to the Security Settings -> Local Policies -> Security Options.

In the right hand pane find the “Interactive Logon: Do not Display last user name” policy and enable that policy.

Note: Remote login is not supported on Mac Students or Teachers.

Send/Collect File Folders

Send and collect an entire folder of files, including subfolders, or send or collect a single file at a time.

Change Machine Display Name

This option does not alter the computer’s actual machine name. However, it will allow an alternative name to be displayed in the Tech Console’s Machine Name field. On Windows, if your computers do not have meaningful Machine Names, you can use this menu option to better name the computers (i.e. “Row 1 Column 5”).

On Mac, there is a Setname utility that can modify names that is available from Technical Support. The name that shows up for a Mac user is controlled by a file called /Library/Preferences/com.lanschool.student.config.plist. This script will write that file using whatever name is passed in, or if nothing is passed in it will set the display name to be the current Computer Name as displayed in the Sharing preference pane. The script must be run as root to have any effect.

For example, to change a Mac machine display name to “Library1”:

    sudo setname “Library1”

Another example—set the display name to the current Computer Name:

    sudo setname

You will have to refresh your console to see a name change.

Change User Channel from the Console

Changes user channels from the tech’s console.

Update LanSchool on Selected Users

Once a user has been installed on a computer, you can remotely update those users from the Tech Console. For more information on this feature, please see the section, “Updating Tech Console and User Machines” in the Installation guide.
Monitor

Remote Control
Take remote control of a single selected user or select multiple users. This feature allows you to remotely use the mouse and keyboard on the selected user’s computer. With Tech Console, you can even remote control a computer at the login prompt.

In order to send the ctrl-alt-del command to a computer during remote control, you may click on the Control button’s chevron menu -> Send ctrl-alt-del menu or the Monitor -> Send ctrl-alt-del menu item.

During Remote Control, the Command key on the Mac is mapped to the Alt key on Windows and the Option key is mapped to the Windows key.

Selecting multiple computers will allow you to remote control multiple computers at the same time, while viewing a single computer in the group. Controlling multiple computers only works if the machines look exactly the same.

Teacher machines are not controllable by default. Selecting a Teacher machine to control will send a permission request to that user with a 15 second response time. Teacher’s may allow or deny the request.

Screen Snapshot
Save a user’s screen to a standard graphic file. (.jpg or .bmp) The date, time and login name are displayed in the saved file. Teacher screens may not be captured.

Toolbar Configuration
The toolbar can be customized in the Configure Toolbar item in the View menu. On a PC, it can also be configured by holding down the “alt” key while dragging the buttons to a new location or removing them by dragging them off the button bar. You can also reset the toolbar back to the default in the Customize Toolbar window.

If there are more buttons on the bar than you can see, they can be accessed through the “>>” chevron button on the upper right corner of the toolbar.

Properties Page
The properties page is a useful troubleshooting tool if you need to know what the last activity on a machine was or find a machine’s current state.

Preferences
Preferences configures how Tech Console works. See the section “Tech Console Configuration Preferences” for more information.
Tech Console Configuration Preferences

The Preferences dialog contains settings that may be changed in four categories.

Tech

Blank Screen Message

Allows techs to specify a message that will be shown when user screens are blanked.

System Tray Notification

Receive a message when the tech’s console is minimized.

User

Remote Control

Determine whether the mouse and keyboard will be available to the user when being controlled by the tech.

Reduce the depth of color during a remote control session in order to improve performance.

Active Application/Website Icon

In the upper right hand corners of the thumbnail you have the option of seeing an icon of the active application and website. This option is off by default but may be applied from the User tab in the Preferences toolbar button or from the Preferences item in the Manage menu.

Show Current Application Icon on Thumbnails

When enabled, this feature shows the current application that is running on the user device as an icon in the upper left hand corner of the thumbnail. The current running application is not shown for Teacher machines.

Show Last Visited Website Icon on Thumbnails

When enabled, this feature shows the website that was last visited by the user as an icon in the upper right hand corner of the thumbnail. Last visited website information is not shown for Teacher machines.